
The aim of the Oceanside Photography Society is to promote learning, sharing  

and the enjoyment of photography in a convivial atmosphere. 

Oceanside Photography Society 

Welcomes Visitors 

 
Visitors may attend two free meetings (either/or  

general meeting or education meeting) before  

deciding whether to join the club. Please check in at 

the membership desk as you enter. The annual dues 

are $48 for the first year (which includes a name tag) 

and $36 per year afterwards. Dues are prorated 

monthly for new members joining  

Meeting Times 

 

General Meetings are held the first  
Wednesday of the month from 7:00 to 9:00 
pm in the West Hall at the Qualicum Beach 
Civic Centre.  
 
Education Meetings take place on the third 
Tuesday of the month at 7:00 pm  in the 
Windsor Room at the Qualicum Beach Civic 
Centre except during July, August and  
December.  
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THE SHUTTERBUG 

This newsletter is published monthly via  
posting to the club website. Back issues 
can also be accessed from the website.  

SUBMISSIONS 

The newsletter team welcomes  
suggestions, questions, ideas and photos 
that illustrate club activities.  
 
Sold an image? Exhibiting? Win a photo  
contest? Taking a photography related 
course? Been travelling and have a story 
and images to share? Other members 
would be interested in hearing about it. 
 

Please send material to the Newsletter 

Team at newsletter.opc@gmail.com 

 

CLUB MEETINGS 

Please remember to wear your name tag to 
club meetings and events.  

Lost your name tag? See Frieda at the 
membership desk to order another, or  
contact her at: 
membership.opc@gmail.com 
 

Due to allergies, asthma and other  
conditions, we request that you do not use 
any fragrance when attending club  
meetings.  

CONTACT DETAILS 
For club executive contact information, upcoming 
general meetings, field trips, education meetings 
and assignments, please visit the Oceanside         
Photographers Society website.  AFFILIATIONS 

Oceanside Photography Society  
is a member of the Canadian Association  
of Photographic Art. COVER PHOTO 

Parksville Polar Bear Swim 

Photo by Vivienne Bearder 

Taken using the Panasonic Lumix FZ1000 

F2.8, 1/1300 sec, ISO 200 at focal length 25 mm 
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A few years ago I became interested in abstract, impressionist and experimental photography.  I have 
tried a variety of interesting and unusual techniques and want to explain one that you may want to try. 

At our November Education Meeting, I shared one method of photo transfer, a process that enables  
you to print a photo onto the substrate, or background, of your choice.  There are methods to transfer      
photos to paper, fabric, wood, glass and virtually any other material you might choose.  Both colour and 
black and white images can be transferred.   

Below are the steps I demonstrated to transfer a high contrast, black and white image to a canvas    
background that had been painted with acrylic paint. 

 

 The process begins by selecting the image you may wish to transfer.  Because I was converting my 
image to high contrast black and white, I selected an image that had a high level of contrast to 
begin with.   

 After make a duplicate layer of the image, convert it to black and white in Photoshop:   Image > 
Adjustments > Black & White.  Adjust the filters in the Black & White menu to increase the con-
trast and eliminate all gray tones.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This is  original image that I used for the demonstration.  It has a high degree of contrast.                
But not all images convert well, even if they are contrasty. There is a lot of trial and error involved.  

Photo Transfer 
By Debra Kuzbik 

http://oceansidephotographers.ca/wp/
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 After creating the most contrasty black and white image possible, go to Image > Adjustments                  
> Posterize.  Move the slider as far left as possible.  This should eliminate any remaining gray 
tones.  Reverse the image if it includes any text so that it transfers correctly:                                     
Image > Image Rotation  > Flip Image Horizontally 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The image after conversion to high contrast black and white.  

 

 Save the image in the size of your choice.  I saved the converted image as an 8 x 10, 200 dpi.                    
It does not have to be high resolution (300 dpi) for this process. 

  

  

 If you have a laser printer you can print the image 
yourself.  If not, save the image to a  flash drive and 
have a print shop print it for you.  I had Print West 
print these for me, 16 x 20, the size of the canvas I 
was using.  This is easily done if the images are print-
ed as an 8 x 10 size at 100% enlargement.  They cost 
$2.00 per copy.  Printing the image in colour is       
significantly more expensive.  

  
This is the 16 x 20, high contrast, black and white   
laser copy. 

http://oceansidephotographers.ca/wp/
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 Now you are ready to transfer the image. But first, trim off large white areas of your image.  This 
will save you a lot of rubbing later! Liberally spread gel medium over the canvas or other substrate 
with a foam or wide paintbrush.  Golden gloss gel medium is the best, but any mat medium will 
work.  These can be purchased at any art shop.  Work fairly quickly so the medium doesn’t start to 
dry.  I have found that I get a better transfer if I cover the image with medium as well. 

 

 Place the image face-down on the substrate.  Smooth it well with your hands, a brayer or an old 
credit card or hotel keycard.  Try not to get medium on the back of the image as it makes it difficult 
to remove the paper.  Lay the canvas face-down on plastic, weigh it down with books and let dry 
overnight. 

 

 Now for the fun part—the big reveal!  This is as close to watching an image emerge in a chemical 
darkroom that many of us will get!  Wet small sections of the image by dipping your hand in a 
bowl of water.  You will see the transferred image through the wet paper.  Wait a few minutes for 
the water to break down the paper fibres. I have tried cloths, sponges and pot scrubbers, but with  
a little practice, you will find you get a better feel for removing the paper with your fingers. 

 

 

After the first wetting, wait for a few minutes     
before rubbing. Vivienne and Michael are rubbing 
off the paper from the back of the image. 

http://oceansidephotographers.ca/wp/
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 I find that the paper peels off easier if I roll it at an angle. 

 Let the image dry, then repeat the process 3 or 4 more times until all paper has been removed.  

 Clean the image by wiping it down gently with a wet wipe or baby wipe. 

 Dip a paper towel into a little olive oil and spread a thin layer over the image.  This will         
dissolve any paper residue that may be remaining.  Let dry. 

 

 

 

 

 

This is the final rubbing.  You can see there is still a 
little bit of paper residue left. 

Wiped, oiled and ready for touch-ups and 
sealing. 

 Once dry, you can touch up with 
paint any areas that need it, or fill in 
or add  details. Don’t forget to paint 
the edges  of your canvas if you 
haven’t already. Let  dry. 

 

 Finally, seal the entire canvas with a 
layer of mat medium. This will pro-
tect the canvas and give it an even 
and consistent sheen and surface. 

http://oceansidephotographers.ca/wp/
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Remembering Eddie 
 
Edward Ryon Makuahanai "Eddie" Aikau (May 4, 1946 – March 17, 1978) is one of the most respected 

names in surfing. He was the first lifeguard at Waimea Bay on the island of Oahu. He saved many lives 

and became well known as a big-wave surfer. "Eddie" was a true symbol of Aloha. Born on the island of 

Maui, Aikau later moved to O'ahu with his family in 1959. In 1968, he became the first lifeguard hired 

by the City & County of Honolulu to work on the North Shore.  

 

Not one life was lost while he served as lifeguard at Waimea Bay. Eddie braved surf that often reached 

20 feet high or more to make a rescue. He became very famous for surfing the big Hawaiian surf and 

won several surfing awards including First Place at the prestigious 1977 Duke Kahanamoku Invitational 

Surfing Championship. The local saying, "Eddie Would Go," refers to his stoke to take on big waves that 

other surfers would shy away from and his courage to make a rescue in impossible situations. 

"Eddie" became involved in perpetuating his Hawaiian heritage. In 1976, the Polynesian Voyaging      

Society sailed the Hokule'a on a successful 30-day, 2500 mile journey following the ancient route of the  

Polynesian migration between the Hawaiian and Tahitian islands. In 1978, a second voyage of the      

traditional sailing canoe was planned. At 31 years of age, Aikau was selected for this voyage as a crew 

member. The Hokule'a left the Hawaiian Islands on March 16, 1978. The double-hulled voyaging canoe 

developed a leak in one of the hulls and later capsized in stormy weather about twelve miles south of the 

island of Molokai. In an attempt to get to land to save his crew and the Hokule'a, Aikau paddled toward 

Lanai on his surfboard. Hours later a commercial airplane spotted the Hokule'a and the rest of the crew 

were soon rescued by the U.S. Coast Guard. Aikau was missing at sea. Despite great search efforts 

"Eddie" was never seen again.  

The finished piece – “Eddie Would Go” 

 16” x 20” Mixed Media Photography 

http://oceansidephotographers.ca/wp/
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Nikon Focus, Make it work for you.— A question about Using Nikon Auto Focus 

 
There is little doubt that one of the most often posed questions involving DSLRs revolves around the 
auto focus system and how to get sharp pictures from your camera. I shoot wildlife a lot and so most of 
what I have to say is derived from years of frustration and trial and error, but especially error! The fact 
is that wildlife is a very difficult subject to focus on because the critters most often are availing         
themselves of the available bush for cover. Grass, trees, forests and so on make for a very confusing          
background for an auto focus camera system. If you allow the camera to decide for itself which area of 
the frame has the most contrast, for example, then be prepared for some interestingly focused           
photographs. 
 
I have had some modicum of success with the following technique. I hasten to add that this may not be 
using all that the camera has to offer, and it may not be what others use, but it does work for me 99% of 
the time. Because I mean that I rarely throw away a picture because of focus problems, composition, 
yes, subject movement, of course, but auto focus on the tree instead of the bird - very very seldom does 
that problem plague me. 
 
I use the centre focus point almost exclusively. It tends to be the most accurate and in my experience, 
the camera behaves better when it is used rather than if any other point is chosen. I will occasionally 
move to the left or right by a couple of clicks if the target is flying in that direction and getting close to 
the camera, but rarely. Also rarely do I focus and recompose with wildlife, I find it much better to get 
the shot and crop a little rather than to faff about and miss the shot in an effort to avoid cropping. 
Similarly, I rarely use the back focus button. For my feeble brain it is something else to remember in   
the heat of the moment. Rather, its something else to forget. Wildlife photography in my view tends to 
be a long walk for a short slide, meaning that one has to wait for ever for a decent shot and then to risk   
missing the shot is unthinkable! 
 
So, I use the centre point. I use AF-C for continuous servo as I want the camera to do what it gets paid 
for and focus all the time I have the shutter mashed. I set the menu item a1 : AF-C priority selection to 
focus, not release. The last thing I want is ten frames a second of unfocused eagle eating small fish. Next 
I place the focus point on the head of the critter and press the shutter. When the camera is focused the 
shutter fires. 
 
I don't get distracted by all the 99 focus points flashing on and off and jumping all over the viewfinder 
as I pan across the landscape trying to keep the bird in the view finder. (as can happen if you choose 3D 
and all focus points) 
 
And that's my secret. I use the simplest set up the camera is capable of and I don't mess with these set-
tings because there is always something that will trip me up if I do. But wait, I hear you cry, I shoot 
mostly landscapes, what should I use? Why use auto focus at all? I answer. Just set your 24mm lens to 
f/11 and the distance scale to 5.7 feet and fire away. Everything from 2.85 feet to infinity will be in focus. 
You don't need auto focus for landscape, architectural , astro, or other types of distance photography. 
(Full moon shots work well with the AF-C). 
 
But for portraits, pets, people and penguins (just for the alliteration) you will definitely want to use AF. 
Shoot your f/1.8 lens at f/1.8 and blur out the background! Revel in the Bokeh! Select which eyelash is 
in focus and which is not. Go Wild! 

Stump a Chump  - Send questions to newsletter.opc@gmail.com 

http://oceansidephotographers.ca/wp/
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But seriously, of course the P for people shooters will need to use AF as their subjects move, but as they 
move slowly and in predictable fashion, this is an entirely useful workflow. Try group area AF (the big 
white rectangle) for one to six people (or penguins) and if more and bigger groups are around, go back 
to    single point and use back button focus for the recompose-and-shoot advantage. I would stay with 
AF-C in all cases except for architectural shooting. AF-S or AF-A will suffice for shooting buildings. In 
fact,  manual focus is a good alternative and the old Hyperfocal distance  works like a hot-damn! For 
those curious about hyperfocal distance, it depends on the focal length of the lens and the used f stop 
and there are calculators all over the internet. Just search under Hyperfocal Distance calculator. (see an    
example calculator below) 
 
This auto focus system is all about manual control. This sounds like a contradiction but in fact it is not. 
If you set the system up for automatically adjusting to the scene in the viewfinder, then the camera will 
select focus based on the criteria programmed into the system. This may or may not coincide with your 
choice or need for where the focal point is located. In order to get the most predictable and                   
desirable  focus point used for the shot it is necessary to limit the automatic function of the camera - in 
most cases quite severely - and to use effectively a manual setting for perfect automatic focus. 
 

Hyperfocal Distance Explained - Photography Life 

https://photographylife.com/hyperfocal-distance-explained 

Mastering Hyperfocal Distance - Amateur Photographer 

http://www.amateurphotographer.co.uk/technique/camera_skills/mastering-hyperfocal-distance-

56978 

 

Stump a Chump  - Send questions to newsletter.opc@gmail.com 
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In 2015 the Oceanside Photographers Club, now the Oceanside Photography Society, had a     
banner year. Membership in the camera club rose to over one hundred, the club hosted an outstanding 
day long workshop with mainland photographer Rick Hulbert, attracting about one hundred attendees, 
and the club placed third overall in the prestigious Lionsgate Nature competition. Not bad for a club 
that almost wasn’t! 

 In 2003 Qualicum Beach resident Bert Speck forgot to cancel a free ad in a local paper inviting 
people to form a camera club in this small Vancouver Island community.  As a result people kept         
phoning him to organize at least one more meeting. Earlier attempts by Bert to attract people to the    
local civic centre were not successful. So Bert gave it one more try, people came and the Oceanside            
Photographers Club that includes nearby Parksville was formed. 

 Overall the club has thrived in its thirteen year history. There was one key bump in 2009 when the 
club ran out of money and the president resigned. The club was heading into oblivion. But one member 
Ed Mosier said it was too much of a good thing to let die. He organized club meetings at a local church 
for $10 a month. He fundraised through garage sales. And he convinced fellow member the late Dave 
Courtice to draft a constitution that expanded club activities with director positions identified to make it 
all happen. A new club website began in September 2010, education meetings became an important 
part of the club, club exhibitions soon began in local galleries and establishments, guest speakers         
regularly addressed the membership. Club members responded. Membership grew to sixty five by     
January 2011. 

 While informal, early club structure was developed enough to allow the club to continue when Bert 
left. An earlier attempt at a club by Ed Thomas completely collapsed when he left town. Bert was         
followed by Richard Sillery as president and then Dave Graham. Early activities included field trips, a 
newsletter pioneered by Robin Pearson and monthly club challenges when members brought in printed 
photos and laid them out for judging at coffee break by members armed with gambling chips.  But the 
greatest strength of the early club was its ability to attract some of the best photographers in the area. 
Founding members Gail Courtice, Dorothy Morrison and Alan Cornall not only shared their images 
with other members but also shared their enormous expertise in actually bringing photographs to life 
and showing them to the world. This sharing mentality has continued to this day and probably is the 
single greatest factor in explaining the club’s enormous success in the nature competition last year. 

 The informal phase and near collapse was followed by the constitution phase. Now we have turned 
the club into a society. One common theme in all the phases is the need for volunteers to run the         
various activities. In December 2011 with a membership of eighty, the club president sent out an urgent 
call for more members to join the board and keep all the activities going. One of the first requests I had 
as new president of the club was to tone down my rhetoric describing the consequences of continued 
key vacancies on the board of directors. But just as an army marches on its stomach so a good camera 
club runs on an ongoing supply of people to keep the good things happening. 

 In closing I have been a member for more than ten years and have loved every minute of it. 

 
Ed Dunnett, President, Oceanside Photography Society (formerly Oceanside Photographers Club)  
January 2017 
 

 Credits: Many credits are due to Alan Cornall, Dorothy Morrison, Gail Courtice, Ed Mosier and 
Frieda van der Ree for discussions on this topic and for supplying material for this short synopsis. 

 

History of the Oceanside Photographers Club 

By Ed Dunnett 

http://oceansidephotographers.ca/wp/
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Oceanside Photography Society Catchment Area 
By Frieda Van der Ree 

On meeting nights some of our members drive 66 km from Courtenay, 45 km from     

Nanaimo and 42 km from Port Alberni.  Falling close to the center of this triangle,      

Qualicum Beach is well chosen as our meeting place.   

We have a new Facebook page and we welcome you to join.  All you have to do is ask and 

one of our Admins will be happy to let you in!  Either click on the link below or search for 

us at Oceanside Photography Society.   

https://www.facebook.com/groups/1815595298689759/ 

FACEBOOK PAGE  - OCEANSIDE PHOTOGRAPHY SOCIETY 

http://oceansidephotographers.ca/wp/
https://www.facebook.com/groups/1815595298689759/
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Logo Design Contest - Get your  design hats on - we’re having a Logo contest.  As we have trans-
formed from a Club to a Society we need a new logo to reflect that change.  Will you be the one to suc-
cessfully design something simple yet strong and instantly recognizable as the logo of the Oceanside 
Photography Society?  Here’s what we want: 

 
 

 

 
 

See - simple!!! 

If you want some assistance there are numerous sites online including one we refer to in David           
Ambrose’s information about lynda.com - a tutorial on Logo Design Techniques which runs for over 
four hours.   There are other logo design tutorials on YouTube using Photoshop.  You can hand draw a 
logo and photograph it.  Just make sure that the image is clean enough that it can be reproduced       
camera ready to be used for many different purposes; we use it for our name badges, on the website, on 
our Newsletter etc. 
 
Once you have your uniquely wonderful design ready you can upload it to the website just as you would 
an assignment image.  Club members will be able to vote for their top three and the top logo design will 
be chosen with management approval - there will be no chance of a Boaty McBoatFace happening 
here!!! 
 
We are excited to see what you come up with as you are such a creative group of individuals.  The       
contest closes at the end of February with the new logo being chosen by the end of April so that when 
the new Executive and our new Calendar year begins in May we will be sporting our new logo!!! 

Ready, Set , DESIGN. 
 

Oceanside Photography Society LOGO Contest 
By Shelley Harynuk 

Lynda.com  By David Ambrose 

At Lynda.com, the subscriptions for access to their training videos can be quite expensive for hobbyists, 
however there is a new development affecting us on Vancouver Island which members may not be 
aware of that makes it a whole lot more affordable...I mean affordable, as in FREE! The only                
requirement is to belong to the library, which is free to join. 
 
Vancouver Island Regional Library ( http://virl.bc.ca/ ) has entered into an arrangement 
with lynda.com that allows library members full access to the complete lynda.com library using their 
library card and login details - go to https://www.lynda.com/portal/patron?org=virl.bc.ca to get     
started. 
 
Personally, most of my learning about photography and editing software has come from video tutorials. 
For anyone else who also finds this form of learning helpful, here is a huge opportunity to learn           
virtually all aspects of photography from beginner to professional; or any of  the other subjects 
that lynda.com cover, for that matter. 

 black and white  or colour on a white background 

 .jpg format 

 fabulous creativity 

http://oceansidephotographers.ca/wp/
http://lynda.com/
http://virl.bc.ca/
http://lynda.com/
http://lynda.com/
https://www.lynda.com/portal/patron?org=virl.bc.ca
http://lynda.com/
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One of the things we hear so often from members at meetings is how much they enjoy seeing the 

slideshows reflecting assignments, field trips or favourites.  They often wonder who took which image 

or where something was taken or what kind of post production was done to create the final                

product.  Because it is clear that our members are curious about others' photos we thought it might be 

interesting to use the Newsletter to share some photos and to tell some of their stories.  So we’re asking 

you to send us one of your photos that you are particularly proud of, emotionally moved by, worked 

hard at getting, post produced to perfection in your eyes - well you get the picture (pun intended).   

 

With the photo we’d like a bit of the backstory.  Why are you proud of it or moved by it?  What were the 

circumstances?  If it is applicable it would be interesting to know what camera you used and some of the 

information like lens type, any EXIF data, weather conditions - especially for those photos you had to 

work hard at getting!!  If it is a post production story we would of course love to know generally what 

software was involved and would really love to see the original photo and the final product and a gen-

eral idea of the steps you took getting from one to the other.  We don’t need a step by step but just          

“I adjusted the brightness and colour and clarity” type of thing or even “I used Topaz Impressions to 

change the look of the photo.” 

 

Depending on the number of images we receive we would like to publish one a month if possible.  It all 

depends on you.  You can motivate others to motivate you.  

Give us Your Best By Shelley Harynuk 

EXIF Data By John Critchley 

How do you access and read it on your own EXIF data, or for that matter anybody's pictures. Here is 
the answer! 
 
iMac computers - open the image in "Preview" simply double click the image from your hard drive. 
Navigate to "Preview" >"Tools" >"Show Inspector"> "EXIF" 
Most EXIF data is now displayed for you in a separate window including the "Image number" (scroll 
down to see it). This is the actual number of shutter firings on the camera A.K.A "Shutter actuations" 
In Lightroom on an iMac. 
 
You can display a variety of information such as file number, ISO, shutter speed, Aperture etc by hitting 
"I" on the keyboard. The information displayed changes if you cycle through "I" three times. 
You can select the information that is displayed by navigating to:- Library > View > View Options > 
"Right click" > "Loupe view". Another window now opens with all available options available for         
selection on both loupe screens.  

On Flickr the EXIF data can be displayed by clicking the "Show EXIF" button on a picture page as long 
as the author has authorized this function. 

There are numerous software pages and programs available through the Google search engine for both 
Mac and Windows machines 
 
Opanda Iexif is just one :- http://opanda.com/en/iexif/download.htm 
Exif data viewer :- http://www.nirsoft.net/utils/exif_data_view.html 

http://oceansidephotographers.ca/wp/
http://opanda.com/en/iexif/download.htm
http://www.nirsoft.net/utils/exif_data_view.html
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Rick Hulbert Workshop Announcement 
By John Critchley 

Those of you who were at the first Rick Hulbert presentation in February know what an informative   

and fun day it was and his next presentation promises to be every bit as informative, entertaining      

and educational as the first. Rick will be continuing to expand on his ideas with this second day's        

presentation, but this does not mean that you will be disadvantaged if you were not able to attend the 

first   meeting. Tickets are on sale now and are strictly limited to a maximum of 100 sales, that being  

the capacity of the room. Sales are on a first com e first served basis and are offered first 

to the Oceanside Photography Society members at the price of $45 each.   

 

Non members (guests) price is $50 each and members may purchase tickets for guests. 

After a short time of being exclusively offered to the OPS members, remaining tickets will be offered to 

surrounding clubs at the same price of $50 each until they are all sold. So don't delay!  

Since there is limited time available at the club meetings for selling tickets, I encourage all of you to 

send me a stamped, self-addressed envelope containing your cheque. I will also be selling tickets at the 

meetings, but in a limited way due to the time constraints. 

Please send your remittance along with a stamped, self-addressed envelope including 

your Name, Telephone number and E-mail address to:- 

Rick Hulbert Tickets 

c/o  John Critchley 

1596 Dalmatian Drive 

Parksville, 

V9P 1Y7 

Note: DO NOT SEND CASH THROUGH THE MAIL!! 

Make cheques payable to "Oceanside Photography Society" 

 

See the next page of this newsletter for a schedule of the planned presentation.  

http://oceansidephotographers.ca/wp/
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"Another Day with Photographer Rick Hulbert . . . 2017 Edition" 

Saturday 11 March, 2017. Doors open 8 AM at the Beach Club Resort, Parksville 

"Following up on Rick’s successful full day presentation in February 2016, we have invited him back to 

expand on his thoughts of how photography can and will enhance your abilities to see and perceive 

this beautiful world we inhabit.” 

 

While he will include a brief review of the fundamentals of his photographic philosophy previously dis-

cussed, he will explore new content designed to increase your understanding of and passion for image 

making.  As a professional teacher of photography, Rick promises to provide both practical and        

theoretical concepts and ideas that will help make your images more meaningful and more memora-

ble. This promise is made to all attendees, regardless of your level of expertise or experience. 

 

Have a look at Rick’s Photo Website including some of his images, his workshops, and his testimoni-

als! http://www.rickhulbertphotography.com" 

 

Schedule of Saturday Presentations—Free parking is available adjacent to the venue.  

 

Morning Sessions: 

9:00am to 10:30am 

Key Compositional Principles that will enhance your Image Making . . . 

Photography with Intent 

 

10:30am to 10:45am 

Morning Break (tea and coffee provided) 

 

10:45am to 12:15am 

The Keys to Pre-Visualizing Great Images . . . 

Photographing Light, Edges, Space, and Depth 

 

12:15am to 1:30pm 

Lunch on your own (Bag lunches are permitted as long as they don’t leave the room) 

 

1:30pm to 3:00pm 

The Keys to Creating Great Images from your RAW files . . . 

From Camera Settings to Editing Workflows 

 

3:00pm to 3:15pm 

Afternoon Break (tea and coffee provided) 

 

3:15pm to 4:45pm     

The Keys to achieving Fine Art Photography . . .  

What it is and How to get there" 
 

http://oceansidephotographers.ca/wp/
http://www.rickhulbertphotography.com/
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The Sweeper 
Wayne Buhr 

Just a Kid 
Roy Watts 

Feline Friend 

David Cotton 
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Winners of Photo Assignment “Portraits and People”                        Colour  

3 

1 

2 

http://oceansidephotographers.ca/wp/
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I Wonder 

Beth Millar 

 

An Old Man 

Wayne Buhr 
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Modern Mexican Cowboy 
Marnee Pearce 

Winners of Photo Assignment “Portraits and People”             Black and White  

1 

2 

3 

http://oceansidephotographers.ca/wp/
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Winners of Photo Assignment “Portraits and People”                        Digital  Art  

Glass Blower 
Bill Trace 
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Standing in Awe 

Roy Watts 

1 

3 

2 

Green Sunglasses and Ice Cream 

Marnee Pearce 

http://oceansidephotographers.ca/wp/
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Club Member News 

Shortly before Christmas, club 

member Marcie Gauntlett sold one 

of her photographs depicting the 

herring fishery. She has a series of 

these displayed at the fishing store 

at French Creek.   

Marcie has a hint for members. 

Finding a display area that is       

especially relevant to your subject 

can increase chances of a sale.  

Congratulations, Marcie! 

View Bug Photography Site: Mem ber Marcie Gauntlett 

has brought to our attention this site where you can enter many 

photo contests for free. However, if you join for $79 (USD) you 

can enter any of the contests, plus view details of other               

photographers who will give you a peer award.  

https://www.viewbug.com/ 

 Photo by Marcie Gauntlett 

The Old School House (TOSH) - Members Show for January 

Several of our club members are participating in this show at the Old School House this month. 

These include Al Westnedge, Levonne Gaddy, Ed Dunnett, Marcie Gauntlett, Carol Anderson,  

Cliff Anderson and Sucha Ollek.  It is good to see our photographers out there exhibiting their 

works.  

 OCEANSIDE PHOTOGRAPHY SOCIETY CLUB EXECUTIVE 2016-2017 

http://oceansidephotographers.ca/wp/
https://www.viewbug.com/
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The Library in the 21st Century 

 

Gone are the days when you went to the library to borrow books and only books.  While that option is 

still available and many of us still do like the feel of reading from cover to cover with all that lovely  

paper in between, there are so many other things you can do at the library or remotely via computer, 

tablet or smart phone.   

 

We are fortunate here on Vancouver Island with the Vancouver Island Regional Library 

or virl.bc.ca as some of us like to call it.  Your free (with id) library card makes you a legal shoplifter - 

you can walk out with armloads of books, magazines, videos, music cds, books on cd without paying a 

penny.  That said, there’s the small aside that you do have to bring them back after three weeks 

(except the videos which are due in a week).  But think of it - you have the world at your fingertips and 

that’s just the hard copy stuff.  Online you’ve got - remember for FREE - best selling novels, classics, 

tutorials etc. that you can download.  There’s a thing called the Freegal catalogue which allows you to 

download free music from the Sony Music Entertainment and keep it.  Zinio allows you access hun-

dreds of magazines many of which are photography magazines.  Mango provides the ability to learn 

72 new languages.  There is stuff for children, teenagers, Hoopla for watching movies. How could you 

not take advantage of this incredible resource.  There are books, videos, magazines on travel, photog-

raphy, post production software, you name it - hard copy, electronic.  Give it a try - you won’t be sorry. 

 

Check out this link to give you a brief overview of the elibrary options including Freegal,                

Hoopla, lynda.com and others.      http://virl.bc.ca/elibrary/evideo 

 

So - I introduce you to your library - not just for readers anymore.  (and did I mention that it's Free?) 

virl.bc.ca 

Shelley Harynuk 

Newsletter Director and Editor 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Editor’s Grab Bag 
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